RIP-MD
User Manual

S. Contreras & A.J.M. Martin

scontreras@dlab.cl | alberto.martin@umayor.cl
## Contents

1 Introduction  
   1.1 Purpose of RIP-MD ................................. 3  
   1.2 What RIP-MD does ................................ 3  
   1.3 RIP-MD flavors and availability ................. 4  
   1.4 How it works .................................... 4  
   1.5 Citing Us ........................................... 6  

2 Getting and Installing RIP-MD  
   2.1 Getting RIP-MD for Linux ......................... 7  
   2.2 Basic installation ................................ 7  
   2.3 Advanced installation .............................. 8  
      2.3.1 Installing RIP-MD as Standalone software ... 8  
      2.3.2 Installing RIP-MD as VMD plugin ............... 9  
   2.4 Getting RIP-MD for Windows and mac OS .......... 11  

3 User Interface  
   3.1 Webserver Interface .............................. 11  
   3.2 Standalone Interface ............................. 11  
   3.3 VMD plugin Interface ............................. 14  

4 Running a Job  
   4.1 Required Input .................................. 18  
   4.2 Running a Job using the Webserver ............... 18  
   4.3 Running a Job using the Standalone software ..... 18  
   4.4 Running a Job using the VMD plugin Interface .... 22  

5 Output Files and Displaying Results  
   5.1 Output Files ..................................... 23  
   5.2 Displaying Results ............................... 25  
      5.2.1 Using the RIP-MD plugin .................... 25  
      5.2.2 Using external software ...................... 29  
   5.3 Output Analysis example ......................... 29  

A Appendix  
   A.1 Definition of Cα contacts ....................... 33  
   A.2 Definition of Hydrogen Bonds ................... 33  
   A.3 Definition of Salt Bridges ..................... 33
1 Introduction

1.1 Purpose of RIP-MD

To perform their function, proteins adopt a three dimensional structure that is mainly determined by non-covalent interactions between its Amino Acids (AAs). The structure of a protein is not static, residues may undergo conformational rearrangements, and in doing so, create, stabilize or break non-covalent interactions. Molecular Dynamics (MD) is a computational technique widely used to simulate these movements at atomic resolution. However, it is very difficult to gather relevant structural and functional information from MD simulations given the data-intensive nature of the technique. Consequently, several tools are often required to perform these highly complex analyses. Among these are Residue Interaction Networks (RINs), which have been used to facilitate the study of static protein structures. In a RIN, nodes represent AAs and the connections between nodes depict the non-covalent interactions that occur in the three dimensional structure of the protein. For this reason, we created RIP-MD, a tool that create RINs for a protein structure.

1.2 What RIP-MD does

RIP-MD generates RINs for static protein structures or from MD trajectory files. The non-covalent interactions defined by RIP-MD include Hydrogen bonds, Salt bridges, Van der Waals contacts, cation-\(\pi\), \(\pi\)-\(\pi\), Arginine-Arginine and Coulomb interactions. In addition, RIP-MD also computes interactions based on distances between \(C_\alpha\)s and disulphide bridges. Results of the analysis can be displayed in an user friendly interface. Moreover, the user can take advantage of the VMD visualization capacities, whereby through some effortless steps, it is possible to select and visualize interactions described for a single, several or all residues in a MD trajectory. Network and descriptive table files are also generated, allowing their further study in other specialized platforms. Furthermore RIP-MD generates correlation plots, where relationships between the dynamic behavior of different parts of the protein can be determined and quantified.
1.3 RIP-MD flavors and availability

RIP-MD comes in three different forms. The first one is as a webserver that can be accessed at http://dlab.cl/ripmd → “Star a Job” tab. This version was thought for people who wants to analyze a single PDB structure without installing anything in local machines.

If you want to analyze a MD trajectory, or a static structure in a local machine, you can go to http://dlab.cl/ripmd, where in the “Download RIP-MD” section you can find the standalone and the VMD plugin version.

1.4 How it works

Basically, RIP-MD performs the workflow shown in fig. 1. Starting from a MD or a PDB file and input parameters (see chapter 4, fig. 1 A) it passes to a preprocessing step (fig. 1 B and 2) where input type, repeated residues and missing atoms are looked for. The next step is to compute interactions between residues (defined in appendix A) and in the last step the output is displayed either with the VMD plugin or on softwares such as Cytoscape1

Figure 1: Workflow in RIP-MD. A) Input structural information and parameters. B) Pre-processing step. C) Definition of putative interactions as defined by the input parameters. D) Generation of output files.

1 www.cytoscape.org
Figure 2: Preprocessing step. Starting with the protein selection all atoms not belonging to an AA are removed, as well as repeated residues. Then, if the structural input is a MD trajectory each frame is extracted, or otherwise a check for the existence of a topology file of the initial PDB is performed. In this last case, if the user wishes it, missing atoms will be added, to end up calculating some AA properties such as secondary structure and SASA.
1.5 Citing Us

At this moment, RIP-MD is under revision, as soon as possible we will add and update the information to cite this work.
2 Getting and Installing RIP-MD

In order to generate a correct local installation of the software, you need to use it in a machine running a Linux distribution, although we know it may work on Mac Operating System (OS). If your still want to use it in Windows and mac-OS, we recommend to use the virtual machine running Ubuntu available in our web page (http://dlab.cl/ripmd). On this virtual machine, RIP-MD is already preinstalled with all its dependencies and you will only need to install VMD. We strongly recommend to use RIP-MD under Debian\(^2\) or Ubuntu\(^3\) Linux distributions since we know it works there. However, if you only want to use the graphical user interface (VMD plugin), you can use it in any system where VMD can be installed, to visualize jobs generated in a Linux machine.

As a second requirement, you need to have python version 2.7 or higher to run the program, however it will not run under python3 due to some dependencies not implemented yet in python3.

If you want to use the Plugin user interface, the only additional requirement is to have installed VMD\(^4\) in your system.

2.1 Getting RIP-MD for Linux

You can download RIP-MD from [http://dlab.cl/ripmd](http://dlab.cl/ripmd), but keep in mind that we only tested it on Linux machines, although we know it may work on Mac OS. In the “Download RIP-MD” tab you will see a table with links to download the software in all available forms. After you have downloaded RIP-MD, you need to uncompress it.

2.2 Basic installation

To simplify the process of installing RIP-MD, two bash scripts are provided and should be run in this order:

- `requirements.sh`: This script should be executed in sudo mode (using sudo in Ubuntu or changing to the super user using su in Debian). This script looks if python pip is installed and if not, the script will install

\(^2\)www.debian.org
\(^3\)www.ubuntu.com
\(^4\)www.ks.uiuc.edu/Research/vmd
it. Once pip is installed in your system, then the script will read the “libraries” file, and will install all dependencies. If an error occurs in this step, try re-running this script.

• install.sh: This script should be executed as normal user. This script will ask you if you want to install the standalone core of RIP-MD, the Plugin version or both and then it will ask the path to where files must be placed.

> Warning: After the installation process you should close the terminal (or use another terminal) before use RIP-MD in order to recognize a new environment variable

> Warning: VMD plugin installation could fail in the last step (i.e., adding the new plugin to file .vmdrc). If it happens, an error text will appear at the end of the installation script, giving instructions on how to fix it

### 2.3 Advanced installation

#### 2.3.1 Installing RIP-MD as Standalone software

In order to install the required dependencies of RIP-MD, the first step is to install *python tk* and *python pip* through the following commands:

- apt-get install python-tk
- apt-get install python-pip python-dev build-essential
- pip install -upgrade pip

After pip is installed, you need to install some libraries using the following command:

```
pip install -r libraries
```
where “libraries” is each of the files placed in the RIP-MD installation folder. This command will install the following python libraries:

- biopython v1.70
- matplotlib v2.1.0
- MDAnalysis v0.16.2
- networkx v2.0
- numpy v1.13.3
- scipy v1.0.0

When these dependencies are met, you need to copy the “RIP-MD” folder into the folder where indicated by the path where you want to install RIP-MD (e.g.: in your $HOME path). The last step is to create a environment variable in .bashrc file. You can do it using the following command:

```
echo "export RIP_MD=$installationFolder/RIP-MD" >> $HOME/.bashrc
```

Where $installationFolder is the path to where RIP-MD folder is located. Then you can run RIP-MD using the following command:

```
python $RIP_MD/main.py
```

### 2.3.2 Installing RIP-MD as VMD plugin

If you want to install the VMD plugin version of RIP-MD, you need to move the “RIP-MD_vmd” folder into VMD plugin path (by default in
/usr/local/lib/vmd/plugin/noarch/tcl/ in Ubuntu/Debian, or in C:\Program Files (x86)\University of Illinois\VMD\plugins\noarch\tcl in Windows), and after moving it you need to rename it from RIP-MD_vmd to RIP-MD. After these steps you need to modify (as Root) the .vmdrc file (usually located in /usr/local/lib/vmd/ in Ubuntu/Debian or in C:\Program Files (x86)\University of Illinois\VMD\ in Windows) and add the following text to the end of the file:

```
 vmd_install_extension ripmd ripmd_tk "Analysis/RIP-MD"
```

Then you can open VMD and in the “Extension” menu, go to Analysis → RIP-MD. If everything was ok, the RIP-MD plugin will appear on your screen.
2.4 Getting RIP-MD for Windows and mac OS

Due some central libraries (for example, MDAnalysis) are not implemented for some OS, in order to run RIP-MD under Windows or mac OS, you need to have installed VirtualBox on your system. VirtualBox is a general-purpose hardware virtualizer, so you can run multiples OS inside your machine. Once you have installed it, you can download an Ubuntu virtual machine with RIP-MD pre-installed from [http://dlab.cl/ripmd](http://dlab.cl/ripmd) → “Download RIP-MD” tab and then selecting the virtual machine link. After download has finished, you can import the virtual machine to VirtualBox following the steps described in this tutorial [https://docs.oracle.com/cd/E26217_01/E26796/html/qs-import-vm.html](https://docs.oracle.com/cd/E26217_01/E26796/html/qs-import-vm.html).

3 User Interface

This section describes in a simple way the user interface of RIP-MD. Additional information about these interfaces can be found in Section 4.

3.1 Webserver Interface

When you access [http://dlab.cl/ripmd](http://dlab.cl/ripmd) you will see an interface similar to fig. 3. If you want to start a new job in the web application, you need to navigate to “Start a Job” tab (fig. 3 red dashed box) and then you will see a window similar to figure 4. This page contains a form to select your protein structure (fig. 4 red dashed line), input parameters (fig. 4 blue dashed line), advanced options (fig. 4 yellow dashed line) and a button to start the job (fig. 4 brown dashed line). For more information on how to start a job using the web platform, please refer to section 4.2.

3.2 Standalone Interface

As standalone program, it use the system terminal to execute RIP-MD as can be seen on fig. 5. For usage please refer to section 4.3.
Proteins are very important macro-molecules that are behind most of the processes that occur in living organisms. Amino Acids (AAs) covalently bonded in a chain form the primary structure of proteins. Nevertheless, in order to perform their function, proteins adopt a three dimensional structure that is determined by non-covalent interactions occurring between the atoms that compose the AAs. This three dimensional structure is not static, the different residues can move, and thus, stabilize or break non-covalent interactions.

Molecular Dynamics (MD) is a computational technique widely used to simulate these movements at atomic resolution. However, it is very difficult to gather relevant structural and functional information from MD simulations and several tools are often required to perform these highly complex analyses. Interestingly, Residue Interaction Networks (RINs) have been used to facilitate the study of static protein structures. In a RIN, nodes represent AAs and the connections between nodes depict the non-covalent interactions that determine the three dimensional structure of the protein. Here we describe RIP-MD, a Visual Molecular Dynamics (VMD) plugin that allows to apply RINs to the analysis of MD simulations of protein.

Our method can generate RINs for static protein structures or from MD trajectory files. The non-covalent interactions defined by RIP-MD include Hydrogen bonds, Salt bridges, van der Waals contacts, cation-π, π-π, Arginine-Arginine and Coulomb interactions. In addition, RIP-MD also computes interactions based on distances between Cα’s and disulfide bridges. The results of the analysis are shown in an user friendly way. The user can take advantage of the VMD visualization capacities, whereby going through some effortless steps, selected interactions described for a single, several or all residues can be shown. Network and table files are also generated, allowing their study in platforms such as Cytoscape. Another relevant product of the analysis carried out with RIP-MD are correlation plots, where relationships between the dynamic behavior of different parts of the protein are easily determined and quantified. Our method was written in python in a highly parallelized fashion. This characteristic, combined with the possibility of calling the method outside VMD, permits to benefit from the use of HPC infrastructures and grants the analysis of very large systems impossible to handle otherwise.

Our method provide new approaches to study the contribution of each residue on the stability and function of protein structures. A possible application of this method is the comparison of networks derived from pairs of homologous protein from mesophile and extremophile organism. In this case, our method provides the means to explain the molecular mechanisms that allow extremophiles proteins to perform their function.

Here we present RIP-MD, a VMD plugin to generate static RINs from protein structures or dynamic RINs derived from MD trajectories. RIP-MD is available free of charge for the academic community and can be downloaded from this page.

**Browser recommendations.**

RIP-MD uses HTML 5 and Ajax/JQuery Technologies, so we recommend to use an updated browser. We highly recommend to use latest version of Mozilla Firefox or Google Chrome (or its fork, Chromium) browsers.

Figure 3: Welcome interface of web version of RIP-MD. The red dashed box highlights the menu to change between different sections of the application.
Figure 4: Start job interface of the web application.

Figure 5: Standalone interface showing all options of RIP-MD.
3.3 VMD plugin Interface

If you installed the plugin, you will see a similar window to that shown in fig 6. In that window you can select and modify some input parameters, such as interactions to be included in the analysis, format for the output and folder where the output will be stored. In this window there is also a tab section to change other parameters. In the “Interaction Options” tab, you will see something like fig. 7, where parameters that define a interaction can be changed. If you click on the “Advanced Options” tab, you will see a window like in fig. 8, where you can select options to add missing atoms, the number of processors to employ, percentage of simulated time to consider interactions to display in the MD consensus graph, and the other parameters. In the “Results” tab, you will see and be able to analyze the results of your analysis. Here, you will also be able to select nodes (AAs) and which interactions will be displayed in VMD or employed to plot Pearson correlations.

Figure 6: Main interface of RIP-MD. Each colored dashed box represents a distinct element of the software. The red box is the Tab menu of RIP-MD; Brown box is interactions and selection to compute; Green box: Output options. Light blue box: Output text of the software. Purple box: Buttons to save the command to execute RIP-MD and button to Run directly RIP-MD.
Figure 7: Interaction Options tab. Here you can modify distance, angle, and all parameters employed to define each type of interactions.
Figure 8: Advanced options of RIP-MD. Light blue dashed box: PDB options, to add missing atoms using PDB2PQR software and the pH to compute it. Red dashed box: MD options, to select percentage of simulation time to define interactions that will appear in the consensus graph, frame to use as representative structure and to display results in the VMD interface, and the frame to start and stop the calculation and the separation between frames to analyze. Green dashed box: other options that can be defined by the user (number of processors to use, path to forcefield file and parameter file).
Figure 9: Results tab. Red dashed box: Interface to select nodes to display in the VMD interface. Light blue dashed box: menu to select which interactions you want to see. Green dashed box: selection menu to define the interactions that will be employed to generate Pearson correlation plots.
4 Running a Job

4.1 Required Input

Two class of inputs are supported by RIP-MD. The first class are MD trajectories, using both DCD and PSF files as input. The second class of input are static structures. In this case, RIP-MD requires a PDB file, and optionally a PSF file. We will perform a little review in the next subsections for the specific parameters for each type of interaction, but for additional information please refer to Appendix A.

4.2 Running a Job using the Webserver

In section 3.1 we learn about the interface of the RIP-MD web application in a summarized form. In this section we will explain in a more detailed way how to start a job using this form of RIP-MD. As can be seen in fig. 1 there are four main sections, where in the red dashed square contains the box to define the input to upload the structural data (a PDB file and an optional PSF). In addition, there are two extra options, the first one is to add missing atoms (including H atoms), and the second option allows to run a job using example files as a way to test what you can do with this software. In the blue dashed square of fig. 1 you have the two options for the output graph format, a job identifier and your email, both optional. The yellow dashed square of fig. 1 you have a button to display options to change the parameters that define interactions. If you click on it you will see something similar to fig. 10.

When the job finishes, If you provided an email address you are going to receive an email with a link to display your results, however if you do not do it you can save the address in your bookmarks (or wait until job is done) and then download results files.

4.3 Running a Job using the Standalone software

The basic command to start RIP-MD was shown in section 2.3.1. However, all options that can be employed with RIP-MD are displayed with a short description for each option using the follow command in your terminal as
Figure 10: Web interface where the parameters that define interactions can be set.
shown in fig. 5.

\begin{verbatim}
python $RIP_MD/main.py --help
\end{verbatim}

The most basic parameters to run a job are shown in the following text box:
-D DCD, --dcd DCD: Route to the DCD file
-S PSF, --psf PSF: Route to the PSF file
-P PDB, --pdb PDB: Route to the PDB file
-sel SELECTION, --selection SELECTION: Protein selection in CHARMM like format (as defined in MDAnalysis) to perform RINs. Default: "protein"
-O OUTPUT, --output OUTPUT: Path to save results
-ca, --calpha: Calculate Cα contacts
-H, --hbond: Calculate Hbonds
-s, --salt: Calculate Salt bridges
-ss, --disulfide: Calculate disulfide bonds
-cp, --cation_pi: Calculate cation-π interactions
-pp, --pi_pi: Calculate π-π interactions
-rr, --arg_arg: Calculate ARG-ARG interactions
-v, --vdw: Calculate Van der Waals interaction network
-c, --coulomb: Calculate Coulomb potential between charged groups of each amino acid as defined in the CHARMM force field
-pc, --Pearson_corr: Calculate Pearson Correlation between residue interactions
-p, --plot_Pearson: Generate plots figures for computed correlations

Running RIP-MD in a console may be difficult, nevertheless, using the plugin you can select your desired configuration and save the command to run it. This will be explained in section 4.4
4.4 Running a Job using the VMD plugin Interface

We have already seen in section 3.3 how to use the plugin and the graphical user interface. So, to compute RINs for your protein, the first thing that you need to do is to load a structure in VMD (PDB, PDB + PSF or DCD and PSF files) then you need to open the plugin and select those interactions together with the protein selection (in CHARMM-like format, for more information please refer to the MDAnalysis web page[6]) that you want to analyze as shown in fig. 6 (brown box). Following that, you need to choose the folder where you want to put the results and the format of the result graphs (fig. 6 green box).

To change any parameter that defines interactions, you can go to the “Interaction Options” tab (fig 7). For more information about the definition of interactions, please refer to appendix A.

Then, in the “Advanced Options tab” you can select the option to add missing atoms (including hydrogens) for a single PDB with PDB2PQR and the pH that will be used to do it (fig. 8 light blue box). If you are not working with a static structure, in the MD options section (fig. 8 red box) you can define the percentage of the simulated time to consider an interaction that will appear in the results graph, the frame to use as representative structure to display results in the VMD window, the starting and ending frame to compute RINs (by default first frame or 0 and the last frame or -1, where negative numbers refer to the number of frames until the end of the simulation, being -1 the last frame, -2 the previous frame, and so on) and the number of frames that will be skipped between the starting and ending frame (by default 0).

Other options (fig. 8 green box) are the number of processors to use in the RINs calculation and paths to force field file and the parameter file (by default 1 processor and local CHARMM files in the installation folder).

In the last step, to run the job, you need to click in the “Run” button (fig. 6 purple box). Nevertheless instead of using the Run button, you can use the command button. After doing it a “Save command” screen will appear and you will need to select a folder to save a plain text file with the command to execute the standalone RIP-MD version. With this command you can run the job locally or in another machine.

5 Output Files and Displaying Results

5.1 Output Files

When a new job is going to be executed, RIP-MD asks for an output folder (or a job ID if you are using the web application). This folder will be the root of a directory that will contain the RIP-MD results as can be seen in fig. 11. There you will find two text files (“output.log” and “README”) and a new folder called “RIP-MD_Results”.

![Diagram of output folder structure]

Figure 11: Result folder structure. This folder is divided in three levels (black, red and blue boxes). Output Folder is used to place all created files. In the second level (red boxes), there will be a log file file (output.log), the README file, together with RIP-MD_Results folder. In the third level (blue boxes) there are folders and files created for results.

Next we show a list that summarizes each file/folder that appears in fig. 11:

- **output.log**: A simple text file that shows the progress or events that happened during RIP-MD execution.
- **README**: Another text file that explains the components created by the software in the output folder.
• **RIP-MD Results:** This folder contains the files with the results of RIP-MD

  - **Attrs:** Folder that contains `.attr` file for each snapshot of the MD (or a single if input is a single PDB structure). Each of these files have the attributes of each frame such as secondary structure and SASA.

  - **Correlations:** Folder with Pearson correlations as a text and/or png format if `plot_corr` option was selected. Only for MD analysis and only if Pearson correlations were computed.

  - **Edges:** Folder that contains `.edge` files for each frame of the MD (or a single if the input is a single PDB structure). Each files present all interactions found.

  - **Graphs:** Folder containing graphs for each interaction computed and a graph containing all interactions (called consensus graph). Supported graph formats are
    * GML
    * EdgeList
    * GraphML
    * Pajek

  Also placed in this folder, there will be a file called “consensus_as_list”. This file is used to display interactions in the VMD plugin.

  - **representative.pdb:** A protein structure in *PDB* format that will be used for the VMD plugin to display both: interactions and protein structure.

  - **topology:** Graph file created only if you calculated VDW and/or Coulomb interactions. This file describes the protein topology (data copied from PSF file if it was provided or created *de novo* starting from the protein structure). This file describes data such as VDW radius and bond distances between different atoms.

  - **nodes:** A simple text with node names and IDs for RIP-MD internal usage.
5.2 Displaying Results

5.2.1 Using the RIP-MD plugin

Once a RIP-MD job is finished, you can display the results in the plugin version. If the job run directly in the plugin version, its results will automatically be loaded and they can be analyzed by clicking in the “Results” tab (see fig. 6 red box). If you use the web application or the standalone mode of RIP-MD, you need to go to “File → Open results”. Then, you need to open an output folder as shown in fig. 12 (red boxes). After this step, click on the OK button (fig. 12 purple dashed box) to load the results into VMD. Now the result section of RIP-MD will look like in fig. 13 and VMD will load your structure that will look similar to fig. 14.

![Figure 12: Choose directory window.](image)

To display interaction in the VMD window, you need to select those interactions that you want to analyze, for example Cα contacts you can also select those nodes to study (an example is TRP23 of segment P1 in fig. 13). Now in the VMD you will see interacting amino acids and dashed lines representing interactions like in fig. 15.

In case you want to analyze the correlation between interactions of pairs of residues, you can select this option and then click in the upper “Display”
Figure 13: Results loaded in the RIP-MD plugin.

Figure 14: Results loaded in the VMD window. Red balls are amino acids, while gray sticks represent peptidic bonds.
Figure 15: Analyzing interactions in the VMD window. Interacting residues are shown as sticks and non-covalent interactions are represented in dashed lines, in this case, Cα contacts.
button (as in fig. 9 green dashed box section). A new window will appear similar to fig. 16 showing the Pearson correlation plot, where you will be able to select determined zones or to save the plot.

Figure 16: Pearson correlation window generated using RIP-MD. Buttons at the bottom of the window will leave you to select determined zones, modify the figure, restore it or save the image. The color bar at the right side show the color code for different Pearson values.

Another possibility is to visualize the number of interactions present at certain percentage of simulated time. To do it, you can select the type of interaction to analyze in the “Select interactions to generate histograms” section and then click on the “Display” button. After this process is finished, you will see a graphic as the one presented in figure 17.
5.2.2 Using external software

If you wish to display RINs in a two dimensions, or if you want to perform some network analysis, you can use Cytoscape to do so. In subsection 5.1 we described the outputs generated by RIP-MD, so you can import into Cytoscape a graph saved in the “Graph” folder. For more information about Cytoscape, please refer to its user manual.

5.3 Output Analysis example.

In order to provide an example, we will use the Nicotinic Acetylcholine Receptor (nAChR), a member of the ligand gated receptor channels family. This protein has five subunits, where the orthosteric site is located in the interface between a subunit α and any other subunit. For this case, we will use the PDB ID 2BG9, a nAChR structure with a resolution of 4Å .

Once the RIP-MD job using this PDB is done (ran with by-default parameters in our example), we will import a graph to analyze it. This is performed by clicking on “File → Import → Network → File” on the plugin interface. A new window will appear similar to Fig. 18 so by navigating it...
will be able to select the desired graph (for more information about Graphs Files, please refer to section 5.1). In this example we will use C\textsubscript{\alpha} contacts graph.

After loading the graph and selecting to display it your preferred layout in Cytoscape, you will see the graph. In the lower part of the screen you will observe a table with information about nodes, so if you select nodes in the graph, the table will change to show you the information related only to your selected nodes.

Many types of centralities can be computed for our network. To do it, you should click on “Tools → NetworkAnalyzer → Network Analysis → Analyze Network”. A new window will appear similar to Fig. 19, where you need to select how to treat your network. For our example we are using an undirected network so we choose the second option. In the bottom table new columns will appear with each node centrality values.

The nAChR has two important cysteine residues in each \( \alpha \) subunit (Cys 192 and 193) that contribute to the stability of the orthosteric pocket. For this reason we will center this example on these two residues in one chain (chain A). A simple analysis to perform is to observe the node degree (the number of edges that have a node). In our example, Cys 192 has a degree of 4 and Cys 193 a degree of 6. To know which residues are their neighbors, we can do left click in each node → Select → Select First Neighbors. In the following table you can show shared neighbors and for each one.
In this way, we will observe that neighbors of these two Cys residues provide a reduced representation of the loop found where the ligand binds to the receptor. To get an overview about how long these residues occupy the acetylcholine pocket, we can use our VMD plugin so it is easy to note that these residues are located in one of the extremes of the loop, but it can not represent the full interface between both chains for the binding site (Fig 20). This could be explained with additional information about the protein, i.e., the protein is in a closed state, instead of being further away from the second chain as it is in the open state.
Figure 20: Representation of neighbor residues of Cys192 and Cys193.
Figure 21: Contact of two $C_\alpha$s of two different residues. The $C_\alpha$s are represented as the red spheres and the dashed line represents the contact.

A Appendix

A.1 Definition of $C_\alpha$ contacts

Protein contact maps are described as a binary $N \times N$ matrix (where $N$ is the number of AAs or length of the protein). In this matrix, each position $i,j$ is set to 1 if the distance between the $C_\alpha$s of residues $i$ and $j$ is $\leq d$, where $d$ is a distance threshold (Fig. 21) [9, 11, 26]. In RIP-MD the default value of this distance threshold is 8Å [27].

A.2 Definition of Hydrogen Bonds

Hydrogen Bonds (HBs) are identified by a geometric criteria: By default, a pair donor (d) – acceptor (a) is considered to be hydrogen bonded if their distance is less than 3Å and the $\chi_{cba}$ angle is greater than 120°, with all $\chi_{cba}$ angles classified as being between 0° and 180° (see Fig. 22.A) [22, 12].

A.3 Definition of Salt Bridges

Salt bridges (SBs) are defined as electrostatic interactions formed between two heavy atoms of opposite charge, where a pair of heavy atoms are within a given distance threshold. In detail, SBs are treated as a contact between NH/NZ in ARG/LYS residues and OE*/OD* in ASP/GLU AAs, and the distance threshold is $\leq 6$Å between those atoms (see Fig. 22.B) [4, 7].
Figure 22: Examples of HBs and SBs. (A) HB defined by the distance $d$ between the two heavy atoms and the angle formed by the electronegative atom ($a$) and the hydrogen atom ($b$) covalently bonded to the other electronegative atom ($c$). (B) SB where $d$ is the distance threshold that defines the interaction.

Figure 23: Example of a disulfide bridge between a pair of cysteins. The covalent bonds are defined by dihedral angles for the C-S-S-C atoms ($abce$) between $60^\circ$ and $90^\circ$ and a distance between the two sulfur atoms ($d$) $\leq 3\AA$.

A.4 Definition of Disulfide Bonds

Disulfide bonds (DBs) or disulfide bridges are covalent bonds formed between sulfur atoms of the thiol groups of two cystein residues [6, 1, 25]. For static structures i.e. a PDB file, RIP-MD allows for the definition of DBs employing a geometric criteria: the distance between the sulfur atoms of two cysteins is $\leq 3\AA$ and the dihedral angle $\chi_{abce}$ is between $60^\circ$ and $90^\circ$ (see Fig. 23). Regarding dynamics structures i.e. a MD trajectory, we do not provide such capability due to non-reactive nature of common biomolecular force-fields in where all covalent interactions need to be previously established [21, 5, 14].

A.5 Definition of cation-$\pi$ and $\pi$-$\pi$ interactions

The delocalized nature of $\pi$-$\pi$ bonds in aromatic systems leads to a higher electron density above and below the ring plane. The latter results in particu-
lar electrostatic interaction between $\pi$ conjugated species and polar moieties, cations, anions or other aromatic rings \[2\]. Among these, cation-$\pi$ and $\pi$-$\pi$ are the most abundant and relevant in biological contexts \[19\]. It is important to mention that in proteins, $\pi$-systems are only found in aromatic residues (Phe, Tyr and Trp), while cations involved in this type of interaction belong to Lys and Arg AAs \[8, 10\].

Cation-$\pi$ interactions occur between a positively charged ion and the face of an electron-rich $\pi$ system (see Fig. 24). Histidine residues are a special case in cation-$\pi$ interactions, as they can act both as a cation or as a $\pi$-system depending on their protonation state. In agreement with Liao et al \[13\], RIP-MD considers His residues as a cation if they present a protonated nitrogen atom, and as $\pi$-system only if they are not protonated. In this way, interactions are defined when an aromatic residue and a charged atom are within a distance threshold $\leq 7\AA$. Furthermore, the angle between the vectors formed by the cation and the center of the $\pi$ system and the normal vector of this $\pi$-system must be between $0^\circ$ and $60^\circ$ or between $120^\circ$ and $180^\circ$ (see Fig. 24.A) \[18\].

$\pi$-$\pi$ interactions occur between two aromatic rings or $\pi$-systems. In RIP-MD these are defined considering a distance between the geometric center of each aromatic ring ($\leq 6\AA$) (see Fig. 25 A) \[13\]. RIP-MD also computes the orientation of each ring with respect to each other and classifies $\pi$-$\pi$ interactions accordingly, as shown in Fig. 25.B.

**A.6 Definition of arginine-arginine interactions**

There are several computational studies that have demonstrated that the guanidine group of Arginines can resonate and stabilize an interaction between the side chain of two Args \[24, 28\]. This interaction between Args can form clusters and is often involved in protein-protein oligomerization, molecular recognition and ligand binding \[20\]. To detect this type of interaction, RIP-MD looks for pairs of Arg residues whose $C_\varepsilon$s are within a distance $\leq 5\AA$ (see Fig. 26) \[17, 20\].

**A.7 Definition of Coulomb and van der Waals potential interactions**

All previously described interactions are a either van der Waals (vdW), electrostatics or combination of these last two. Indeed, from a first-principles
Figure 24: Cation-π interactions. (A) Example of the interaction between a benzene ring and a cation. This interaction is defined by a distance threshold \( d \leq 7\text{Å} \) and the \( \zeta_{abc} \) between 0° and 60° or between 120° and 180°. (B) Example of the interaction between a Arginine acting as a cation, and a Tyrosine acting as the π-system.

Figure 25: Description of π-π interactions. (A) Example of the interaction between two Phe residues. This interaction exists if the distance between the centroids of the two π-systems \( d \) is \( \leq 6\text{Å} \). (B) Definition of the possible orientations of the aromatic rings. These orientations are: Parallel orientation, T-shape with face to edge, T-shape with edge to face and L-shape.
Figure 26: Arginine-Arginine interactions. This interaction is detected when the distance \( (d) \) between \( C_\zeta - C_\zeta \) is \( \leq 5\text{Å} \).

perspective, all interactions at the molecular level are Coulombic in nature. Thus, inspired by standard MD algorithms\[23\], RIE-MD includes procedures to compute vdW and Coulomb interactions, as it will be explained below.

In RIE-MD, vdW contacts are computed using a 12-6 Lennard-Jones potential \( (V_{LJ}) \) described by Eq. \[1\]

\[
V_{LJ} = \epsilon \left( \left( \frac{\sigma}{r} \right)^{12} - 2 \left( \frac{\sigma}{r} \right)^{6} \right)
\]

where the distance between an atom pair is represented by \( r \), while \( \sigma \) and \( \epsilon \) respectively are the zero energy distance and the depth of the potential well. These are specific for each atom type, being force-field dependent and are either obtained from when a single structure is provided or the corresponding parameter file if a MD trajectory is submitted to RIE-MD.

vdW contacts are defined as shown in Fig. 27. In this figure, atoms 1 and 4 can form a vdW interaction since they are separated by at least three covalent bonds and the distance between the spheres that represent their van der Waals radius \( (d) \) is within -0.1Å and 3Å.

To reduce the computational cost caused by the calculation of interactions between each pair of atoms, all coulombic interactions are computed employing a charged-group based cut-off using a 1-4 potential (see Figures 27 and 28)\[23\] 35 15 16. Thus, interactions between pairs of fully or partially charged atoms pertaining two charged-groups, CG1 and CG2 and within a give cut-off are calculated via:
\[ V_{Coulomb} = \frac{1}{4\pi\epsilon_0\epsilon_{cs}} \sum_{i\in CG_1} \sum_{j\in CG_2} \frac{q_i q_j}{|\vec{r}_{ij}|} \]  

(2)

\( \epsilon_0 \) and \( \epsilon_{CS} \) are the permittivity of vacuum and the simulated media, respectively. Usually, \( \epsilon_{CS} \) is set to 1 when simulating in explicit solvent conditions. \( \vec{r}_{ij} \) is the distance vector between particles \( i \) and \( j \). In general MD simulations are run under periodic boundary conditions to avoid surface effects. The latter leads to spurious electrostatics as the \( \frac{1}{r} \) does not converge across the box copies. Several strategies exit to alleviate these artifacts, such as lattice sums and the Reaction Field (RF) method. The latter is quite computationally expensive, thus in RIP-MD a modified Coulomb potential using the RF formulation is employed. In detail, apart from the so called Coulombic term (see Eq. (2)) two extra terms that mimic the effects of the surrounding solvent are added.

\[ V_{DD} = \frac{1}{4\pi\epsilon_0\epsilon_{cs}} \sum_{i\in CG_1} \sum_{j\in CG_2} \frac{-q_i q_j C_{RF} \vec{r}_{ij}^2}{2R_{RF}^3} \]  

(3)

\( j \) inside cut-off \( i \)

and

\[ V_{DI} = \frac{1}{4\pi\epsilon_0\epsilon_{cs}} \sum_{i\in CG_1} \sum_{j\in CG_2} \frac{-q_i q_j (1 - 0.5C_{RF})}{R_{RF}} \]  

(4)

\( j \) inside cut-off \( i \)

with \( C_{RF} \):

\[ C_{RF} = \frac{(2\epsilon_{CS} - 2\epsilon_{RF})(1 + \kappa_{RF} R_{RF}) - \epsilon_{RF}(\kappa_{RF} R_{RF})^2}{(\epsilon_{CS} + 2\epsilon_{RF})(1 + \kappa_{RF} R_{RF}) + \epsilon_{RF}(\kappa_{RF} R_{RF})^2} \]  

(5)

where \( \epsilon_{RF} \) is the RF permittivity, \( \epsilon_{CS} \) is the permittivity of the solvent, \( \kappa_{RF} \) is the inverse Debye screening length, usually set to 0 for explicit solvent MD and \( R_{RF} \) is the RF cut-off. Eqs. (3) and (4) are known as the distance dependent and independent terms, respectively. Eq.(2) is not evaluated for excluded atoms (those connected by 4 or less atoms, e.g. a torsion angle), while Eqs. (3) and (4) are evaluated for these atoms, as well.

38
Figure 27: 1-4 Potential for Coulomb and VdW interactions. These interactions are computed if the interacting atoms (atoms 1 and 4) are separated at least by three covalent bonds. Also, the potentials are computed in a distance threshold $d$.

Figure 28: Example of residue charged groups. In this case Alanine is divided in three charged groups (colored circles) as defined by CHARMM topology file.

Given the long-range nature of Eqs. (2), (3) and (4), a raw RIN is rather impractical for visualization purposes. We have adopted two strategies to alleviate this issue: an interaction is considered only if it is above $k_B T$, where $k_B$ is the Boltzmann constant and $T$ is the temperature in kelvin; all interactions are consolidated at the residue level, in other words a node, i.e., an AA, can have multiple edges i.e. an interaction, based on it constituent charge-groups (see Fig. 28).
References


